
 
 

“GIS Short Course” 
Tift County Georgia 

 
 
 
 
 
 
 

GIS is a methodology … a system … a discipline 
Not a specific software program 

 
 
 

The concepts given here can be applied to any GIS program, 
as can most of the techniques and tricks. 

 
 

(This course is in no way definitive, exhaustive … or guaranteed accurate) 
 
 
 

This course uses the TatukGIS Viewer, version 1.10.1.362 
free from www.tatukgis.com 
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Caution 
 
GIS data layers used in this class are for use by Tift County officials, staff and other authorized persons  only. 
 
Many are not final products because they are  still being edited or updated. 
 
Do NOT give away, sell, loan, or otherwise distribute the Tift County data without permission from: 
     Roads, addresses, hydrants, schools – Vickie Hickman@ Tift E-911 
     Others – Tim Spivey@ Tax Assessors 
 
 
 

 
 

Color keys used in this lesson plan 
 

Blue text refers to buttons, menu choices, or windows  in the Tatuk Viewer program 
 
Red text refers to warnings or advsory notes 
 
Magenta text is for general emphasis 

 
BEFORE  PRINTING maps for the public 

 
100-year floodplain – 

The 100-year floodplain data layer in GIS is for reference ONLY.  
Any decisions regarding floodplains must be made using the official paper “FIRM” maps. 
Do NOT print the 100-year floodplain from GIS on maps for the public.   

 
Tifton city limits –  

This GIS data layer was created for property tax purposes. 
Do NOT use it for enforcement or emergency response decisions. 
If you include it on a map for the public, advise the client that the city limits line is for reference 
only. 

 
2007 USDA color aerial photos 
 Photos were taken for crop analysis 

For technical reasons, they do not align with our roads, parcels, etc. 
 Amount of detail visible (“resolution”) is less than in the 1997 black&white aerials 
 
Add a “disclaimer” and date 
Any printed map should include a disclaimer containing language to the effect that Tift County 
assumes no legal liability for the map’s use, or for the data used to create it. 
 

Examples - 
 
“This map is for reference only; no legal accuracy is implied. Data used is from County, state, 
Federal and other sources. Map produced on 0/0/00 by the Tift County XXXX Department.” 
 
“This map is for reference only; Tift County assumes no legal liability for the map’s use or for the 
data it contains. Map data comes from County, state, Federal and other sources. Map produced on 
0/0/00 by the Tift County XXXX Department.” 
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Some basic GIS terms & concepts 
 
Project – a document or file in which you put together the data layers you wish to use 
      - a project is only a “roadmap” or index of the layers; it does NOT store all the data a layer contains 
 
Feature – a line, polygon, or point, any of which can be viewed, selected, and analyzed 
 
Record – in a database, a horizontal line of information 
  
Field – in a database, a vertical column of information 
  
Polygon – a 2-dimensional feature which is completely enclosed by a line, such as a circle or square, or  
  the outline of a jigsaw puzzle piece 
 
Layers or shapefiles 
 Think of layers as glass with data displayed on them. 
  The layers can be rearranged so that one appears to sit on top of the other. 
 As you stack more layers, you display more data 
  Layers can be displayed in different colors, to differentiate between them 
 

  
 
 Layers can be: 
  - added, using Add Layer 
  - removed, using Remove Layer 
  - made visible, by placing a check in the box next to the layer name 
  - made invisible, by unchecking the box next to the layer name 
  - moved, by highlighting a layer name and dragging it up or down in the Legend  
 
 Layers can contain: 
  - text 
  - polygons, such as parcels 
  - lines, such as roads 
  - aerial photos or other images 
 
 A layer must be active - highlighted in blue in the Legend window - before TatukGIS can  
  perform any operations - such as queries or displaying information 
 
 
There’s another key GIS concept called: 
       Making a backup – copy your Tatuk project to a CD, thumb drive, floppy disk, network server, etc

3



Some map layers for Tift County, available now  -- 
 
Parcels - 
 

 
 
 
 
Roads  - 
 

 
 
 
Addresses - 
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Landlot lines  - 
 

 
 
 
 
 
Tax map boundaries - 
 

 
 
 
 
 
Dams, rivers/streams - 
 

 
 
 
 
Wetlands - 
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Soil types - 
 

 
 
 
 
 
100 year floodplain - 
 

 
 
 
 
Mobile homes and lots - 
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Cel towers - 

 
 
 
 
 
Relationships - 
 

 
 
 
 
 
 
Zoning - 
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Subdivisions - 
 

 
 
 
 
Also – 
Bridges  Commission districts  Mobile home parks Schools  
Tifton Historic District  Groundwater recharge areas 
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Getting Started 
 
To open a  map “project” 
 Double-click on the map file in My Computer or Windows Explorer -- in this case “class.ttkgp” 
 

   
 
 
The project will open to the main window – 
 

   
 
 
 
 
If you do not see 2 windows named Selected and Legend 
 Pull down the View menu to Panels, then choose Selected and Legend 
 
 Windows can be moved and re-sized to suit your preferences 
  If you’re lucky enough to have 2 monitors, data windows can be moved entirely off of the main window 
 
 
 
 
Here are the main tools in the toolbar, below the pull-down menus - 
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Some tool notes – 
 

The Zoom Mode tool, or zoom to box, works in several directions – click and drag southeast to zoom in, click  
and drag any other direction to zoom out.  

 
The Zoom Extended tool works in 2 directions – click and drag away from you to zoom out, click and  
drag toward you to zoom in.  
 
The Drag Mode tool works in all directions – click and drag to “slide” the map around the screen.  
 
The Zoom to full extent tool will cause Tatuk to show the entire extent of your map.  
 
The Previous Extent (or Back) tool works like the Back tool in a web browser.  
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Adding map layers –  eg. aerial photo #47 
 Pull down the Layer menu and choose Add 
 

   
 
 
 
In Windows, navigate to the Aerials folder and select 47.tif (an aerial photo in TIFF format) - 

   
 
Click Open to add the layer to your Tatuk project 
 
If the aerial photo is not visible on your screen 
 Click once on the layer name in the Legend, eg 47, to highlight it in blue & make it active 
 

 Click on the Layer Extent button   
 This will zoom to the aerial photo 
 

This tool also works with layers in the Legend such as roads, parcels, etc
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Moving layers in the Legend 
 
If an aerial photo is added, it will appear at the “top” of the layer stack  and will cover up any layers below it 
 
 This is aerial photo #47  after being added to a project 

Note that it obscures the layers below it - 
 

   
 
 
To move a layer up or down in the Legend, do a “drag and drop” -- 
 Left-click on the layer name (here 47) and hold the mouse button down 
  Then drag the layer up or down in the Legend 
   Here, you want aerial photo 47 to be below the roads, parcels & addresses - 
 

   
 
Release the mouse button 
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 Note that the other layers now show on top of the aerial photo - 
 

   
 
 
 
 
To remove a photo at the end of a session 
 Click once on the layer name in the Legend, eg 47 
 Right-click & select Remove 
 

 

 
 
 
 

It’s a good idea to remove photos from a project regularly, unless they’re used often
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Changing the appearance of lines and points – 
 When you add a new “polygon” layer such as parcels, all the polygons will be filled with grey 
 

Add the “parcels_calendar2006” layer to your project 
 Layer/Add menu, then open the Shapes folder 
Double-click on the layer name and this window opens - 

 

   
 
 
 

Click the tab named Area, then click the button named Area 
 Choose transparent in the Pattern pulldown window 

 

   
 

14



Click the Apply button to preview the changes – see next illustration 
 

Click the UO Uutline button, and hit the button under Color to select whatever color you want 
  The Width window lets you control how wide a line is 
   .5pt and 1pt are a good starting point 
 

   
 
 

Click the Apply button to preview the changes 
 

When you’re satisfied, click OK 
 
 
 
 
The “Wizard” button 
 Used for assiging different colors to different features within a layer 
  Eg zoning classifications, soil types, political districts 
 
 The Wizard is beyond the scope of this class 
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Setting highlight option for selections you make on screen – the color that appears around a selected item 
 

Pull down the Tools menu, choose Options, then click the Selection tab in the Options window 
 Click on the black triangle next to Selection Color to open a color picker window - 

 

   
 

Outline Only is the best if you’re going to be printing - 
 

   
 

Otherwise it will print as an area of solid color - 
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Labeling -- adding parcel numbers, road names, etc  
You have LOTS of choices here - the following illustrations show the effects of some settings 

 
Double-click on a layer name, in this case parcels_owners 
 The “Vector” window will open 
 
To chose a typestyle - 
 Click the Label tab, then click the Label button 
 Click the Font button to select typestyle, color, bold, etc 

Pull down the menu next to the Field box, and choose PIN (Parcel Identification Number) 
Put a checkmark in the Visible box - 

 

   
 

Clicking the Apply button will show you the effect without closing the selection window - 
 

   
To select the positions where labels will be displayed – 
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 Click the Position button and you will see choices for Position and Alignment 
  Choosing 5 and Center will center the label in its polygon 
 
 Clicking the Apply button will show you the effect without closing the selection window - 
 

   
 
 
 
 

Outlined labels – best avoided - 
 

   
 
 

To get rid of the “halo” effect around text, shown here –   
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 Double-click the appropriate layer in the Legend window 
 Click the Label tab - 
 

   
 
 Double-click the Color bar, change the color to black – select the color box shown by the red arrow - 
 

   
 
 
 Click Apply to see the changes, then click OK - 
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After setting up your project the way you want it (labels, colors, etc)  
 
 ** MAKE A BACKUP COPY ** 
 In My Computer or Windows Explorer, find the “.ttkgp” & “.~ttkgp” files and copy them to a safe place - CD, etc 
 

   
 
 OR 
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Getting information about a parcel, road, address point, etc – 
  
Each of the layers (shapefiles) includes  a database - called an “attribute table”  in GIS 
Databases contain many fields (columns), each with different information or combinations of information. 
 
 Here’s an example of what a database contains - eg. the Parcels_owners layers - 
 

   
 
Accessing database info 
 Information from a layer’s database can be shown in the Selected panel 
 
Example: if you’ve found an area by moving around in the map 

  Click on the    Select Localize tool to activate the “finger” tool - 
 

   
NOTE – this tool will select whatever feature (line, point, polygon) is closest to the index finger tip 
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Click on a feature, eg an address point shown as gold points 
 The feature will become highlighted 
  Information from the database will appear in the Selected window in the upper right - 
 

   
 
 
 
Next, click on a parcel line (but not on an address point) 
 The parcel will become highlighted 
  Information from the parcels database will appear in the Selected window - 
 

   
 
 
Next, click on a road, the road segment will highlight 
 Information from the roads database will appear in the Selected window - 
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Getting rid of a highlight 

 Hit the Deselect     button on the toolbar 
 
 Or right-click on the feature and choose Deselect All - 
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Some Data panel basics 
You have been given printed samples of databases, showing the fields they contain 
 Use these samples to determine which field to use when doing searches & queries, and to see formatting  
  (spelling, abbreviations, etc) 

NOTE – if you’re not from Tift County, your county’s database fields WILL have different names 
 

Open the Data Panel by clicking on the Data button   , then stretch the panel to the left & right 
 Pull the top edge of the data panel window up, until you can see at least 3 rows of records 
 
If you select a feature, eg. a parcel, the database for that feature will appear in the Data Panel - 
 

   
 
 
If you then select a different type of feature, eg. a road, its database will appear in the Data Panel - 
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Controlling which layer a feature is selected from - 
 

Click on the black triangle at the right of the    Select tool, pull down the menu & choose  
                     Select by Point       
  
 
 
 
This tool will ONLY find things in the “active” 
layer in the Legend - the layer highlighted in blue 
 

 
 
 
This is handy if you have a complex project, packed with features in different layers 
 
 
 
Right-clicking to pop up a menu  
 
 Many Tatuk actions or commands are found by right-clicking (or “alternate button”, for you lefties)  
  Or by clicking the Operations button in the Data Panel 
  
   
  To zoom to a feature you’ve selected or found  

 Right-click anywhere on a record (line) in the Data Panel 
 Select Zoom to Current Shape - 
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 Or to Flash a selected feature to find it (here a road)  
  Right-click on the record & choose Flash Current Shape - 
  

   
 
 
 
You’ll get practical experience with these 2 functions
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More Data panel basics 
 
“Cached” and “non-cached”  
 In the bottom left corner of the data panel, you’ll see a button called Operations  
   This is where you can turn the cache mode on or off 
 
 
 Cached means all the records (eg. road names) will show up if you click the pull-down menu by a field name  - 
 

     
  
  
 
 Non-cached means none of the records (eg. parcel #) will show up if you click the pull-down menu by a field name - 
 

   
 
 Setting the cached and non-cached options  

27



  
Open the Options window 

 Use the Options button    on the toolbar, or select Options under the Tools menu  
 
 Select the Data Panel tab  

 
 Choosing Auto Cached means Tatuk will count the number of records a database contains  

 You can tailor this to your own desires – “less than” sets the threshold 
 
  If you often scroll down through field pop-up lists, set the record count above 18,000 (for this course) - 

 

     
  

 
 
 
 
 

Some class layers which have databases containing more than 10000 records –  
 Parcels  
 Addresses 
 Roads 
  
 
 
 
 
 
Note – you can make fields (columns) wider 
 
 Using the Address layer 
 Put the mouse cursor on the line between columns 
  The cursor will turn into a black “cross” with left & right arrows 
  “Click & drag” the cursor to the right and release the mouse button - 
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How GIS sorts numbers 
 
 When working in databases, most GIS programs sort numbers in a “1,10,2” pattern – 
 

1 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
2 
20 
21 
and so on 

 
T1 
T10 
T11 
. 
. 
. 
. 
. 
. 
. 
T19 
T20 
T21 
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Finding a specific feature 
 Such as parcels, roads, addresses … anything in a database 
 
 Your first option is to do a Simple search – here, searching the Parcels_owners layer 
 
 In the Legend, click on the Parcels_owners layer -- highlights it & loads the database into the Data Panel 
  Using the scroll bar on the right, scroll down through the database until you see the record you want 
   Here, the PIN field, looking for 10-19   (parcel ID number 10-19) 
    Select that record by clicking ANYWHERE within the line  of the record - 
 

   
 
 
 Or – if the database is cached 
  Click on the black triangle to pull the PIN menu down 
   Scroll down to the PIN you want, eg. parcel 10-19 - 
 

   
 Tatuk will select ONLY that record in the database, eg. parcel 10-19 
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 Right-click on the record and choose Zoom To Current Shape to display the selection - 
 

   
 
 

 Use the    Select by Point tool to highlight the feature and show information in the Selected panel 
 
 
When you find a feature either of these ways, your selection first appears in the Data panel 
 Only after you use one of the Select tools will information appear in the Selected window 
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The most flexible search option is to do a Custom Query 
 
Querying for parcels - 
 In the Legend window, click the parcels_owners layer to make it the active layer 
 
 The layer’s database appears in the Data window - 
 

   
 
 
 Pull the field menu down for the field you want to search – click on the black triangle 
  In this exercise, the PIN (parcel ID number) field  
 You’ll see “All”, “Custom”, “Blank” and possibly more- 
  Select Custom - 
 

   
The Query window appears 
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 Note that PIN has been automatically selected - 
 

   
 
 
 
 
Pull the left menu down to equals - 
 

   
 
 
 
 
 
You’re going to search for parcel # 10-19 
 To the right of equals, enter 10-19 with no “leading zeros” (not 0010 or 019) - 
 

   
 
Hit the OK button 
 
 
 
Note – type in the target info (eg 10-19) using whatever format is used throughout the field you’re searching 
 For example - if the database is set up using 0010  019 for parcel numbers, enter it that way 
      - if the database is set up using St instead of Street, type in Main St 
      - if the database is set up so that N (north) follows Tift Ave, type in Tift Ave N 
 
 
 
 
(more)
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Tatuk will show your target in the Data Panel 
 
 Right-click on the record and choose Zoom To Current Shape to display the selection - 
 

   
 
 
Note that the Data panel is covering part of the screen and the selected feature 
 To see the entire parcel, zoom out or move the data window 
 
 
 
Use the Select by point tool and click inside the parcel lines 
 Information about the parcel will appear in the Selected window - 
 

   
Then right-click on the record in the Data Panel and choose Flash current shape - 
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 The selection will briefly flash red & yellow - 
 

   
 
 
To clear this selection and show all the records in the database 
 Click the X box in the lower left corner of the Data Panel - 
 

   
 
 
The entire database will now be visible, AND your custom query entries will be retained - 
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Exercises 
 
Querying (searching) for address points  
 
In the Legend window, single-click the address  layer to make it active 
 The Data panel will show the address database (open the Data Panel if necessary) 
 
 Scroll the database (to the left or right) until you see the Address field 

 This field contains the complete address with house #  
 

 
 
 Widen the Address field if you desire 
 
 
Pull down the Address field menu (click on the black triangle) & choose Custom - 
 

  
 
 
 
 
 
 
 
 
In the Custom Query window 
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 Pull down the lefthand menu to equals 
 Enter 816 baldwin dr as the address you want, upper or lower case does NOT matter - 
 

   
 
Hit OK 

 
 
 

The search result will appear in the Data panel 
 

Right-click on the record and choose Zoom To Current Shape to display the selection 
 
The address point will be hard to see - 
 Right-click on the record and choose Flash current shape 
 
 

Use the Select by point   tool to select the address point and highlight it - 
 

  
 
 Information about the point will appear in the Selected window 
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Finding a road, by query 
 
In the Legend window, put a check mark next to the roads layer 
  If you have labels set for the road names, they will appear 
 
 Then click once on the roads layer to highlight it & make it active 
  The roads database will appear in the Data panel 
 
  Widen the RDNAME field (column) - 

 

   
 
 
 
 
 Pull down the RDNAME field menu to Custom - 
 

   
 
 
 
 
 Enter equals and academy dr as your search - 
 

   
 
 
 Hit OK 
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 In the Data Panel, 2  records will show -- because there are 2 road “segments” named Academy Dr 
 
  GIS constructs roads as segments which run from intersection to intersection 
  Longer roads will have correspondingly more segments  - 
 

   
 
 
 
 
Right-click on any 1 of the records and choose Select group and zoom to - 
 

   
 
 
 
 
 
 
(more) 
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The 2 road segments will be highlighted - 
 

   
 
 
 
 
 
 
 
To clear this selection and show all the records in the database - 
 Click the X box in the lower left corner of the Data Panel 
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“Wild card” search 
  
Use this: 
- if you’re not sure of the spelling of a name 
- if you want to search for any address starting with certain numbers 
- if you don’t know whether a street is a Lane, Court, Drive,  etc 
- you get the idea 
 
 

 
Reminder – in order for a simple search of a database to be successful (as in earlier examples), 
you must enter your search text exactly the way it is stored in the database. 
         

This search will not work :    Database contains You type   
        Highway 319 S   US 319 South 

 
 
 
 
 
 
The Wild card 
 
 The expression Like and the %  sign are used in a wildcard search 
  % represents an unknown value – a whole word or part of a word 
  Use the % sign as part of a word, or separate it with a space 
 
  Search spelling    Search results 
  Thomas %      Thomas Jefferson, Thomas County 
  Thomas%      Thomasville, Thomason 
  Thom%       Thompson, Thomas, Thomasville 
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Exercise 
 
Searching for 1301 Crescent - without knowing it’s a Drive 
 Make the address layer active, open the Data panel if it’s not open already 
 Use the Address field, start a Custom query - 
 

  
 
  
 Enter like and 1301 crescent % as your search – using like in the left-hand box 
  Important - put one space before the % sign; this separates the wildcard from a known value – 
 

   
  
 Hit OK 
 
 The result will show in the Data panel as 1 record - 
 

   
 

42



Right-click on the record and choose Select Group and Zoom To, to display the selection 
 The point for 1301 Crescent Dr will highlight – here it’s been circled in red 
 The Selected window will show info - 

 

   
 

 Right-click on the record and choose Flash current shape 
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Variations on wild card usage 
 
Use this form, with a space between a road name and %, if you know the full name but not the road type - 
 

   
 
 
 
Use this form, with part of a name including the % if you’re not sure of the road name or spelling 
 Note – there is no space before the % sign - 
 

   
 

This could find any address containing 1301 Cres 
 1301 Crescent Dr 
 1301 Crescendo Ln 

 
 
 
 
All results (“hits”) will be shown in the Data Panel, where you can pick the one(s) you need 
 Here a wildcard search for 10 Tifton% found Tifton Eldorado Rd and Tifton Worth County Line Rd - 
 

   
 
 
 
 
NOTE – though the above examples refer to road and address searches, the % wildcard can be used for searches of 
any layer which has a database containing text or numeric data.
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Finding the intersection of 2 roads 
 
 In the Custom query window, you’ll do an “OR” search 
 
Make the Roads layer the active layer 
 
Here, a search for Newton Drive and Tiffany Road – when full road name and spelling are known 
 
 On the RDNAME field, pull down the menu to Custom - 
 

   
 
 
 
 Query window 
  First line -  equals  newton dr 
  Click the OR button 
  Second line - equals  tiffany rd - 
 

   
 
 
 
Hit OK 
 
 
The Data panel will show the results of the query - 
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Click the Operations button in the Data panel  
 Choose Select group and zoom to - 
 
 

   
 
 
 
Both roads will be highlighted at their intersection - 
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Abbreviated example of a wildcard search for Main Street and Poplar 
 Not knowing if Poplar is a street, road, or drive 
 
 Remember, a query for road intersections is always an “OR” search 
 and a wildcard query is always a “like” search 
 
 Start a custom query of the RDNAME  field 
 
  First line – equals and main st 
  Click the OR button 
  Second line - like and poplar %  (space between poplar and %) - 
 

   
 
  Click OK 
 
 
 
 In the data panel, click the Operations button 
  Choose Select Group and Zoom To 
 
 Here’s the final result - 
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Example of a wildcard search for Main Street and Poplar 
 Not knowing how Poplar is spelled 
 
 Hints – an intersection query is always an “OR” search 
              - when using the wildcard %, use “like” in the lefthand box 
 
 Query window 
 First line,  equals &  main st 
 Click the OR button 
 Second line, like  &  pop%   - 
 

   
 
 
Hit OK 
 
 
 
Here’s the final result, after “zooming to” - 
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Complex queries 
 
 Searching for several specific items – eg first name, last name, street, address 
 
This works for searches in which the info you want is in more than one database field – 
 Here, names are broken into fields Lastname, Firstname & Address1 
 

   
 
 
 
Exercise 
 
Seach for a parcel owner, in a database in which the first and last names are in different fields 
  
The parcels layer must be active, here the parcels-gap_calO6 layer 
 
Searching for Joann Smith 
 
 First do a Custom Query of the LASTNAME field 
 

   
 
 
  Use equals & Smith - 
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Click OK  
 
 The Data panel will show many results - 
 

   
 
 
 
 Then do a Custom query of the firstnames field - 
 

   
 
 
 Firstname equals joann - 
 

   
 
 
The Data panel shows the one record - 
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Wildcards can be used as well in complex queries 
 
 
Abbreviated example 
 Here, first name something like Joan….  Smith (Joan, Joann, Joanas) 
 First do a custom query for last names equals Smith 
 
 Multiple records will show in the data panel - 
 

   
 
 
LEAVE the data panel as it is, do NOT remove the x in the lower left corner 
 
 
 Then run a custom query on first name field using  like &  Joan% 
  The % is your wildcard - 
 

   
 
 
 
 
 The Data Panel will display the results - 
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To see where all the Joann Smith results are in the county 
 
 Click the Operations button in the Data panel  
 Choose Select group and zoom to  
 

The results will be highlighted (the red arrows in this illustration are not part of Tatuk) 
 If they’re hard to see, Flash each record in the data panel 
  Right-click on the record and choose Flash current shape - 

 

   
 
 
 
 To close the search results and return to the full database 
  Remove the X from the box shown below, and wait while the database loads - 
 

   
 
 
Notes – 
Queries are not case-sensitive. Use upper or lower case when typing 
 
Queries can be made more detailed 
 Eg. search for last name, then first name, then acreage or street 
 
Searches are not limited to the examples shown here 
 You can search for partial addresses, partial street names, etc. 
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Advanced queries – only for the adventurous 
 
Click on the query builder button 
 

   
 
 
 
Using this syntax window is beyond the scope of this class 
 

   
 
You’re on your own with this ….. 
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Determining a land lot number “on the ground” 
 
 Make the “landlots” layer active – click on the layer name in the legend 
  Be sure there is a check mark next to the name – otherwise you will not see the landlot grid 

 Click the Layer Extent   button to zoom out 
 

   
 
  

 Use the Select by Point    tool & click on the map 
  The land lot # will appear in the Selected window - 
 

   
 
 You could also search the database to find a landlot
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Determining which aerial photo (image) you need to add 
  
 Turn on the “image grid” layer & make it active in the legend 
  Be sure there is a check mark next to the name – otherwise you will not see the image grid 
 

 Use the Select by Point      tool & click on the map in your area of interest 
  The imag_grid area will be highlighted 
  The aerial photo # will appear in the Selected window 
 
 In the Selected window, IMAGE  is the aerial photo number 
   In this illustration, photo 67  - 
 

   
 
 
In real life, you will probably be looking at a smaller area of the county, such as a neighborhood, parcel or road 
 Use the above procedure to determine which aerial photo to add to your project 
 
 Just make sure the imag_grid layer is active and visible 
 Use the Select by Point tool, and click on your area of interest 
 Look in the Selected panel for the Image number
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Measuring distances 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click on the Measure tool   
 

 Note the pull-down menu indicated by the black triangle 
 This is where you select the kind of measuring you want - 
 

   
 

 
The Measure Line and Measure Polygon tools 
 As the mouse is clicked, the tool labels each point 
  0 is the anchor (starting) point 
  The red point is the most recent (last) point 

 
 

Note - measuring tools leave a “trail” or line behind them 
  - the faint yellow dotted line may be hard to see 
 

  
 Be sure the Tatuk project is set to measure in feet 
 
  Click the Map menu, select  Map Units, then select US Foot - 
 

   
 
 

   
 
 
 ** Save your map project after setting or changing map units ** 
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To measure individual lines around an area 
For this exercise, find parcel 17-13 , zoom to it, & close the Data panel 
 
Choose the Measure: line tool 
 The Measure Panel will appear on screen by the Legend 
 
To measure the green property lines 
 Click at the starting point, then at the next point 
  The starting point will be labeled 0, the next point will be labeled 1  - 
 

   
 
 
As you continue to click, the Measure window will show you the total lengths of all the line segments 
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To measure the next line by itself, without adding its length to the previous line - 
 Click on top of  the “0” point, the starting point, to delete it 
 Then click at a new point - 
 

   
 
 
 
(Repeat this process around the area) - 
 

   
 
Tip – to delete a measuring point, click on top of it to select it, then click again to delete it
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To adjust or change a measuring line 
 
First, add aerial photo #17 to your project (this will make the measuring lines easier to see) 
 Pull down the Layer menu, choose Add, open the Aerials folder, select 17.tif 
Then in the Legend, move (drag) the aerial until it’s below one of the parcel layers 
 
Start measuring a new area 
 Set (click to create) several points 
 
 Click on top of a point and hold the mouse button down 
 Drag the point to its new position and release the mouse button 
  (This is known as a “drag & drop”)  
 
 
 
  In this illustration, point 1 has been dragged from one circled position to a central position - 
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To calculate the area of a polygon (an enclosed area such as a pond) 
 
 Be sure aerial photo #17 is added to your project, then “pan” to the west until you see a small pond 
 
 
 
 
 
 
 
 
 

   
 
 
 
Choose the Measure: polygon tool - 
 

   
 
 
 
 
 
 
(more) 

 
Note that there are NO scroll bars along the edges of the Tatuk window 
 
 Use the hand tool – click & drag the hand to the right to move the image to the right 

Imagine that you’re moving the photo around behind a window cut in a sheet of cardboard 
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Click at a starting point, then at the next point, and so on - around the pond 
 The starting point will be labeled 0, the next points will be labeled 1, 2, etc 
 
 As you click around the pond, the yellow measuring line will appear to “rubber band” 
  and the Area and Length windows will continuously update 
 
 The Area window in the Measure panel will show area in square feet - divide by 43560 to get acres - 
 

   
 
 
Different ways to change the shape of a measured area 
 Click on top of whichever point you want to move, hold the mouse down and drag the point to a new spot - 
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Or click on a line to add a new point 
 Here, a point midway along the right side of the pond - 
 

   
  
 
 
 Then try clicking on top of the new point, and drag it to another place - 
 

   
 
 The Area and Length windows will always update in real time 
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To delete any point at any time 
 Click once on top of it to select it 
 Then click again to delete it 
 

   
 
 
 
 
 
To remove the measuring lines and  “dismiss” the measuring tool 
 Choose another tool, eg the Select tool 
 
 But be wary of the Remove Layer button 
  If you hit it, whichever layer is active will be removed 
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Printing 
 
TatukGIS will print on the full area of the paper – using the settings in your Windows default printer 
 This is an example of a print on letter-size paper in “landscape” (wide) orientation  - 
 

   
 
 
 
 
 
 
 
Paper sizes 
 TatukGIS has been tested to print on paper as large as 11x17” (tabloid size) 
  To print on different sizes of paper, change your Windows default printer settings 
  To print a tall map rather than a wide map, change your default printer settings to “portrait” 
 
 
 
 
 
 
 
Print preview 

Use the Print Preview     button to make choices on how you want the print to look 
 NOTE –if you don’t use the preview, some printers may print more than you see on the monitor screen 
 
 
 
 
(continued)
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 You have the option to print a title, date, Legend window, & Minimap window (if the minimap panel is 
open) 
  Scale factor is best left un-checked unless requested – this prints as a numerical value, not a bar or ruler 
   Hit the Refresh button to see any changes you have made in this preview window 
 
  In the Sub Title window, enter your map disclaimer (see page 2 of this manual) 
   You can save your disclaimer text in Notepad, then Copy & Paste it into the Print Preview window 
 

   
 
 
 Click the Full Preview button to see what the print will actually look like – 
 

   
 
 Then, of course, click the Print button – in the upper left corner of the preview window 
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Including the Legend on the print 
 
If you want your print to show the Legend & layers - 
 Be sure the layers have been configured so that their symbols are visible in the Legend in the project window 
 
Example: 
 Here the lines and points for roads, parcels and addresses have been set to “visible” in the main Legend window 
  That is done by double-clicking on a layer as you would to change colors 
   Put a check mark in the “Include in legend” box - 
 

   
 
 
 
 
 In the Print Preview window, put a check mark in the Legend box, then click on Full Preview 
  You will see  each layer represented by its name and symbol 
  Note that this Tatuk project contained many layers (illustrated above), but only 3 will show on the final print 
- 
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E-mailing a map 
 
You can save your map as a file that can be attached to an e-mail 
 NOTE – the Selected and Legend windows will not be exported 
 
PDF files – 
 TatukGIS can create Adobe Acrobat PDF files, excellent for e-mailing 
 

 Use the  Print to PDF    button, or menu File/Print to PDF 
  A print preview window will open  
  Choose what you want to show on the PDF - 
 

   
 
  
 Hit the Print to PDF button 
  Pick a location on your computer to store the PDF 
  Give the PDF a name – 
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Export as an image 
 
 An alternative to PDF is to create an image file (snapshot) 
 Image formats available include JPEG (best for aerial photos) and TIFF 
 

 Use the Export to Image    button, or File/Export to Image 
 
  In the Save As Type pull-down menu, select JPEG (.jpg), TIFF (.tif), etc - 
 

   
 
 
 
 For JPEG (.jpg) you have choices 
 
  Note that under Resolution, best quality creates the largest digital file, for web creates the   
   smallest file 
 
  Increasing file Compression makes the file smaller BUT with a loss of detail in the image 
 
  The settings illustrated here are good defaults 
 

   
 
 
 Note to finicky folks – JPEG is designed to compress photographs and will NOT give you the most detail 
  in the exported image 
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To export as a TIFF (.tif) file 
  This will yield the highest image quality but also the largest digital file 
  Not recommended for e-mailing - 
 

   
 
 
 
 For TIFF (.tif) you have these choices 
  Note that under Resolution, best quality creates the largest digital file, for web creates the  
   smallest file 
 
  If you want to compress the file, pull down the Format window to 24 bit LZW 
  Use compression ONLY if you know that other software can read compressed TIFF files - 
 

   
 
 
 
 Click Save and a progress window will tell you when your file is finished and ready to e-mail - 
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“Scaling” a map  -  Printing  at a specific scale, eg 1:100, 1:200, 1:400 
 So that a ruler can be laid on the print to determine distances. 
 
 
First get your map looking the way you want. 
 
 
At the bottom of the Tatuk project window is a data entry window 
 Here it reads 1:1200, which means 1”=100’ (1 ruler inch = 100 feet of ground distance) 
 

   
 
  (If there’s nothing in this window, you need to set the project’s map units) 
 
 
 To change the scale, delete everything after the colon 
  Then type in your new scale number 
   For a 1”=100’ map, enter 1:1200 
   For a 1”=200’ map, enter 1:2400 
   For a 1”=400’ map, enter 1:4800 
  Hit the Enter key on your keyboard - 
 

   
 

Then proceed with printing, using Print Preview if you want 
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After changing the scale to 1:2400 (1”=200’), this is the result – 
 

   
 
 
 
 
 
 
Advisory –  
When printing, be sure your printer is set to print at 100%, not “fit to page” or a similar setting 
Make some test prints with your printer to see if you need to adjust the scale number you enter in the scale window 
 
NOTE – scaling will not be accurate if the map is exported as a PDF or an image file (JPEG,TIFF, etc). 
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Saving a project 
 
There is no simple Save button or menu item in Tatuk 
 
First, look at the name of your project, in the upper left corner of the Tatuk window – 
 

   
 
 
 Go to the File menu, select Save Project As 
 
  In the Save As window, find & select the file with the same name as you see in the upper left corner of 
the  
   Tatuk project window - 
 

   
 
 Click Save 
 
 This window will appear - 
 

 
 
 Hit Yes to save the project 
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Closing your project 
 
 When you close a project window, Tatuk may ask – 
 

   
 
 Hit Yes 
  You will go through the Save As routine above 
 
 
 
 
 
 
 
 
 
** IMPORTANT – danger Will Robinson ** 
 
If you look in My Computer or Windows Explorer, you will see 2 files that have similar names 
 In this case, class.ttkgp and class.~ttkgp 
 
 Do NOT delete the file that has .~ttkgp  at the end of its name - 
 

   
 

   
 
 
The map project will NOT open if you delete the .~ttkgp  file 
 Only throw it away if you delete its mate 
 
YOU HAVE BEEN WARNED 
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Miscellaneous stuff 
 
 If you’re using TatukGIS and a window comes up asking if you want to download an update – 
  Select NO – because the new version may be significantly different than the one you’re using now 
 
  Download the new version to your computer and install it separately to evaluate ut 
   You can run multiple versions of TatukGIS 
 
 
 
 Handy tools to play with - 
  
  Select the “Zoom Extended Mode” tool and try it out 
 
  Select the “Drag Mode” (the hand) tool and use it along with your mouse wheel 
   Use the mouse to drag the window around, and the wheel to zoom in and out 
 
  Use the “Previous Extent” button to go back to the last places you looked at 
 
  To select more than one feature using the Select Localize tool (the hand), press the Ctrl key 
   on your keyboard 
 
  The pull-down menu by the Select Localize tool gives you many selection options to try 
 
 
 
 
 
Q. - “I downloaded a map file (from the internet), and when I add it to Tatuk, it shows up somewhere in Alabama” 

A.  - You’ve encountered a “projections” issue.  E-mail the file to Tim at the Tax Assessors and he can re-project 
it  
 to the proper place on the ground. 
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Tips about labeling 
 
 The Tatuk software uses invisible points within each feature as its “label location points”. 
   Eg. each parcel has one invisible center point, each road segment has one center point, etc. 
  It will not “stack” lables on top of eachother. 
   Do not try to cram too many labels from different layers into the same small area, eg a parcel 
 
 The optional Label position settings uses the invisible points, and will help you stagger or offset labels in 
  tight areas 
 
 
This illustration simulates how the software decides where to put labels on the parcels and roads layers. 
 Each parcel enclosed by property lines is a closed polygon with one center point. 
 Each road segment, from one intersection to another, has one center point. 
 

   
 
 
 
 
 
 
 
 
 
 
Labeling complex layers such as zoning, soils, etc 
 If you have set different colors for different areas such as zoning classifications or soil types 
 
This is just a quick overview – you have many options to try out 
 
 
 
 
 
 
 
(continued) 
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 Double-click on the layer you’re labeling, select the Label tab, then click the Label button 
 
  In the bottom window, select each “Visible” item, such as (Class=’M-H-P’) 
  In the Field window, choose the field you want to use for labels, here the Class field 
  Repeat for each visible item 
 
  Put a check in the “Visible” box 
 

   
 
 
 
To set the typestyle for your labels, click on the button below Font 
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This opens the font selection window 
 Set size, color, etc, to your preference 
 

   
 
 
 
 
 
Labels have a Position setting 
 To get it, click the Position button while the Label tab is selected 
 

   
 
 
 
 
 
 
Position #5 places labels on the invisible label points (remember?) 
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Additions, questions or comments? 
Call Tim Spivey at the Tift County Tax Assessors 
229/386-7840 
 
 
 
 
 
 
 
 

Produced by the 
Tift County Tax Assessors 

GIS Department 
June  2008 

Rev. 4 
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Saving and re-using color & label settings for layers 
 
After you set your color and label preferences for a layer, you can apply the same settings to other similar layers. 
 
First save your color settings 
 Right-click on a layer namein the Legend 
 

  
 
 
 Choose Save layer properties 
 
 
 
  The Save As window opens - 
 

    
 
  Choose a place to save the color settings .ini file 
  Give the .ini file a name related to the layer 



Then select the layer to which you want to apply the color & label settings 
 Right-click on the layer and choose Load layer properties - 
 

  
 
 
 
 
  The Open window appears 
   Select the appropriate .ini file 
 

    
 
   Hit the Open button to apply the settings. 
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